Immersive Environments

Goals:

Simple World Creation 2 Methods

Load up Maya

. Autodesk Maya 2018

m Autodesk Maya 2018

Build Object: Island 1

Aim: To use the create polygon tool and multi cut tool to generate an island.
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Grab a copy of the above image and then save it to your desktop. Then load up Maya.



As this is a top down view of Iceland, we will go to the top view of Maya. When you look at this map,
notice the contours of where the mountain ranges are. We will need to add these elements to our
map, though in this particular case, we won’t be aiming for a large amount of details, just a quick
overview.

Open Maya to top view

From here, insert the image using the view->image plane->Import image menu
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Select the image, | have mine stored on the desktop.
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From here, you can then use the Mesh Tools->Create Polygon to encircle the island, like we did with
the car in the previous tutorial.

Mesh lools | Mesh Display  Curves  Surface:
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Append to Polygon
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To make things easier, remember to zoom in on your map.



Work your way around the island, if the shading is too much, you can see just the outline by turning
off the smooth shading in the view panel by going to wireframe.
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You should circle the entire object and then hit enter to complete your polygon.

(N
o
0
=
i
=
=L
o=
q
wj

Kefl
Intern:

Airf

Ocen

100 Miles

This will create a polySurface. From here jump into perspective mode. From here Extrude the poly to
give it some depth.



Now that we have a singular object to work with, we can start to carve it up with multiple faces,
adding in the edges will allow us to apply more details to the object.

From the menu, select Mesh Tools->Multi-Cut and start adding additional faces to the object
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Swapping to the top view, add multiple faces to the object. End each cut of the object by pushing the
Enter key.

After you have applied some cuts through the object you should have something like this
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From here, you can go into the perspective mode and extrude the faces, in this manner starting to
build more definition to the island. On a side note, the more faces an object has, the more detailed
the model will be and the more it is able to add curves to itself.

With some extrusion, the island can look like this
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With some aspects being raised and lowered as you would like. The main reason for constructing a
world in this manner is that there is only a single face on the underneath side of the object.

Build Object: Island 2

Aim: Create a base world in a graphical tool, import into Maya and then build the world based upon

that base image.
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This image was created in paint 3d, as you can see, it’s not detailed, but does supply the rough idea
on what to put into place for an island world.
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From here, go to the top view in Maya. Spacebar to get to the views, then click and hit spacebar to
maximise the top view.

From here, as we did last week, use the view’s menu system to import the image.
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From here, jump back to perspective view

Now that we have our blueprint for the island that we will create, start with setting up the base
area, to do this we will create a cube for the island and then a plane for the water. The island could
be done with just a plane to start with, but by using a cube, we can extrapolate and build rocky
shores, beaches and other such elements.

To start with, add a plane from the create menu to the custom shelf. Create->Polygon Primitives ->
plane, Ctrl+shift + left click on icon. This should give you the following.
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Select the cube and Go to the attribute editor, change the name to islandBase
List Focus  Attributes Show  Help

islandBase

Focus

transform: islandBase , Presets

Show Hide

From here go to the polyCubel tab and make the following changes

- Width: 16

- Height: 0.2

- Depth8

- Subdivision Width: 20
- Subdivision Height: 4
- Subdivision Depth: 20
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From here, swap the object to vertex mode and start arranging the edges to match the outside of
the map.

This would best be done from top view, before moving into side or perspective view, as this will
allow for the designated shape to start with. You should end up with something similar depending
on the drawing you made:
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Notice the section near the beach, we can tidy this up by adding extra lines and dropping the face
under the water plane, we have yet to make. To do this, switch to edge mode and then use the
insert edge tool.

Once this is done, place the newly created vertexes on the edges of the map. Then switch to
perspective mode, highlight the new faces in the beach area, switch to side view and push them
down.



Once in Perspective mode, change the view to allow for
wireframe on shaded and turn off x-ray.

This should then allow for the following view.
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From here, we can start to push and pull out faces of the island to give it a better shape. We will also
lower the lake area and river section.

Jump in and out of x-ray view to ensure you are sticking close to your image, remember this is not
pixel perfect so you can change sections up.

Remember to maintain shape to add extra vertex through the insert line tool. This will allow for a
cleaner environment.

Remember we have the ability to extrude items (Ctrl+E) here’s an example of the lake/river system.



All of the faces for it have been highlighted.

From here, the elements are extruded, then scaled in a
little, extruded one more time and then the faces are
pushed down.

This produces the following look

To see what it will look like, we will now assign a base land colour. Swap from face or vertex mode,
depending on where you are and go to object mode




Once you are in object mode, right click on the object and go to Assign New Material
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Next, to see the colour applied to the object, in the view menu you will see a checker box, click on

this.
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This will appear in the view scene.
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Next, we will create a simple blue plane in which we will ‘place’ the water around the island. Switch
to top view, then in your custom shelf, click on the plane.
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From here, scale the plane out to be larger than the island base, assign a material to it and then use
the move tool to position the water plane to be visible in the lake and river section of the scene.
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In this case, instead of a blinn, an ocean shader was applied, this gives the overall image, after
manipulating the height the following look

If the water plane hides too much of the island, you can lower the faces of the river/lake area. Next,
we will put in some shapes for the mountain, remember to switch on x-ray mode, so you can view
the underlying image map.

From here, I'm swapping to top view, and then manipulating vertexes.

The primary goal is to create large faces for the
mountain, once that is done, the extrapolate
tool can be used to generate additional edges,
height and faces to work with.

From perspective mode, once you have the faces, you can use the extrude tool to generate
additional items needed for the design.



Next, we can populate the forest section., in this case we will construct a very simple tree design.
This tree design will consist of a brown cylinder and green cone.

Once you have built the tree, you can group the objects together
(Ctrl + G) this then makes duplication (Ctrl + D) much easier.
Once done, populate the forest.

If you examine the outliner, the grouping can be shown like this:
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Once of the things with groups is that you can have groups within groups, for example:

This can allow for world population to occur quickly.

i group?
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From here, we can add simple houses to simulate the village.

For the house, it’ll be a simple cube with the roof extracted out and faces removed to create
door/windows.

From here, duplicate the house and populate the village.

From here, you can modify and grow the mini world as much as you want.



Unity
Unity Overview

Unity is a game engine with the ability to create 3d and 2d environments. Unity’s prime focus is to
allow for the quick creation of a game from freelance to professional. It contains some modelling
capability.

Goals:

- Introduction to Interface
- Simple model creation
- Player control of model object

Load up unity

. Unity 2017.1.0p5 (64-bit)
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If you don’t have an account, you will have to create one. Otherwise sign in with your registered
account.

Create:

Create a Unity ID

s.costain@griffitheduau || sesseseeenen
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agree to the Unity Terms of Use and P Policy ‘ Create a Unity ID

Sign in:



Sign into your Unity ID
If you don't have a Unity ID, please create one.
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Click on Create Project, this will open Unity into its default layout



Like Maya, there is a bit of learning with the user interface, so let’s first change from services to
Inspector and have a look.

In the top right, click on the inspector tab

This area will populate when you have objects in the game world or you select an object.

Let’s look at the User Interface, there are 5 main areas:

- Toolbar

- Hierarchy Window
- Project Window

- Inspector Window
- Scene View

Toolbar
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This is the only part of the Ul that cannot be re-arranged, it contains the most used buttons for
interacting with the interface.



Hierarchy Window

This is a listing of all elements that are within the current project. This allows for the ability to have a
parent item with children, i.e. groups of similar objects

The Project Window

‘Eproject [T Eensele I ———

Assets

The project window displays all the assets that are in the project. These can be stored in folders to
allow for ease of management. This is where the imported assets go.



The Inspector Window

The Inspector window is a graphical view of an asset. Be
it a 3D object, camera or light source. Any element in
the scene will have a matching field in the inspector
window. The add component button allows for
additional elements to be added to an object, these
items can be items such as rigid body, gravity, scripting
for control and so forth.



Scene View

3 Scene
| Shaded v|[20 || % | <) | & i7| | Gizmos ~| (@A

The scene view is where elements of the game are placed, allows for visual navigation and editing of
elements. This can be done in either 2D or 3D perspective based upon the project.

Unity Key Shortcuts

Tools

Keystroke Command

Q Pan

w Move

E Rotate

R Scale

T Rect Tool

Z Pivot Mode toggle

X Pivot Rotation Toggle



\Y Vertex Snap

CTRL/CMD+LMB  Snap

GameObject

Ctrl/Cmd+Shift+N New empty game object

Alt+Shift+N New empty child to selected game object

Ctrl/Cmd+Alt+F Move to view

Ctrl/Cmd+Shift+F Align with view

Shift+F or double-F  Locks the scene view camera to the selected GameObject

More Keys here: https://docs.unity3d.com/Manual/UnityHotkeys.html



https://docs.unity3d.com/Manual/UnityHotkeys.html

Load up unity
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Build Object: Lights and Primitives

Aim: Building simple primitives and testing lights

Create a new project and get into the default view.

To start with we will create the following primitives

- Plane

- Sphere
- Cylinder
- Cube

This is done by right clicking in the hierarchy panel and selecting 3D Object. Select each object and
then using the move tool position the primitives around the plane.
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To do this, select the Directional light in the hierarchy panel

Cube
Sphere
Capsule
Cylinder

Plane

~ N

Cube
Sphere
Capsule
Culinder

Once the objects have been created, you can select them individually in the hierarchy screen and
move them around, create the following pattern.

To start putting in lights, we will turn the directional light’s intensity down.




Directional Light

Then in the Inspector panel, change the intensity from 1to 0.1

© Inspector
. |¥# [Directional Light | ] static ' | [Directional Light | O static ¥
Tag|Untagged ¢ Layer [Defaul Tag |Untagged  i| Layer (Default &

As you can see, when this happens the scene lowered from an intense white to a blue environment.
Now, we can add some additional lights.

To start with let’s create a point light. To do this, right click in the hierarchy panel and select light->
Point light.

Create Empty
3D Object

2D Object
Effects

Directional Light
Auco C o pomuge
Video > Spotlight

This will create a light in the centre of the plane, drag it up and move it around the objects.



Once you have it on the far side of the sphere, in the inspector panel, turn on the shadows.

© Inspector
# [Point Light | [ static v
Tag|Untagoed ¢ Layer |Defae ]

@ Realtime indirect bounce shadewing is not supported for Spot and Peint lights.

O Inspector
™ [Point Light | [ static v
Tag | Untagged 4| Layer | Default 3

d for Spot and Point lights.




You will notice that there is a dramatic change in the way that the scene looks, Move the point light
around, so you can visualise what will happen for movement and shadows.

Have a play with the settings, such as range, intensity and colour. You can create a lower grade
orange light with minimal work.

© Inspector

¥ Point Light | [ static ¥
Tag | Untagged 4| Layer | Default |
¥ .~ Transform R
Position X3.794 Y |0.52 Z(1.124
Rotation X0 Y0 zZ0
Scale X[1 Y[1 Z|1
v . ¥Light 5
Type Point £l
Range 6
Color |V 4
Mode Realtime 3]
Intensity 0.8 |
Indirect Multiplier |1 |

r 1

Next, we will add a spotlight. Right click in the hierarchy and select Light->Spotlight

Effects > I

Light > Directional Light
Audio > Point Light
Video > Spotlight

Ul > Area Light
Camera Reflection Probe

Then using the move tool, position the spotlight on the cylinder.

¥ Spot Light | [ static
Tag | Untagged +| Layer | Default

¥ .~ Transform -
Position X|-1.753 Y 2.641 Z|-1.812
Rotation X 58471 Y |26.625 Z -6.414001
Scale X[1 ¥[1 z[1

v MLight E
Type | Spet
Range 10
Spot Angle Cr 30
Color | | |
Mode | Realtime
Intensity 1
Indirect Multiplier 1

As you can see, you can play with the intensity, range, colour and spot angle.



® Inspector
¥ [Spot Light | CJ static =
Tag [ U d 4| Layer | Default 4]
o7 ¥ .~ Transform ]
Position X|-1.753 2,641 Z-1.812
Rotation X (58471 26.625 Z -6.414001
Scale X1 1 Z|1
v ' W Light R
Type | Spot N
Range 10 |
Spot Angle O 100
Color ||
Mode | Realtime |
Intensity 2 |
Indirect Multiplier 1 |
r |

Build Object: Maya and Unity merging for a project.

Aim: To show a simple tip to make the importing of maya models into unity.
We will start with a new Unity project:
Load up unity
B Unity 2017.1.0p5 (64-bit)
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Create a new project and remember the location.

<
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In this case, the project will end up on my desktop in a sub folder called Immersive Environments.
Once the project has been created, go to the assets panel and create the following folder structure.

3 Project

I Create 'l

V{}Flwnrltes Assets »
) All Materials
' All Models

oy L §

W Materials Materials Scenes Scripts
W Models
&l Scenes
&l Scripts

Models is the path we are going to use for placing our Maya models.

Now that this is set up, let’s jump into Maya.

From here, quickly create a simple block layout for a street which is next to a playing field.

Now, the trick to making this work is the saving of this project. From here, go file -> save scene as
and then locate the folder in which the unity project is placed.



M Autodesk Maya 2018 - Student Version: ul

File | Edit Creat Select Modify Display Wini

New Scene Ctri+MN []

Open Scene.., Ctri+0 [

Save Scene Ctrl+5 []
Save Scene As... Ctrl=Shift+=5 [ ]

Increment and Save Cirl+Alt+5

y\lmmersive Environments)
Name

General Options

v Default file extens

3D Paint Texture Options

Set Project...

Save As

Cancel

Save As

Files of type: Maya Binary Cancel

Once the file has saved, go back into unity. There will be a little bit of time as unity repopulates the
assets folder, but once done you should see the following:



' Create ~|

v . Favorites Assets » Models
O All Materials
© All Models
© All Prefabs

¥ i Assets
W Materials streetBase
®= Models
Wl Scenes
@ Scripts

Notice that there is a materials folder that came with the model. This allows for the model and
elements to be transferred into unity as a whole. This will avoid missing textures and so forth. From
here, you can drag the model into the scene view.

If you expand the model, you should see the following
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This is all of the primitives and materials assigned to the object.

From here, drag the streetBase onto the scene, you will have to scroll out and rotate to see it, but
unity should contain the following




Now that we have the model in place, we can lower the directional light and add some spotlights to
the field spotlights.

Drop the intensity to 0.1

© Inspector

¥ Directional Light [ ] Static =
Tag | Untagged ¢ | Layer | Default $ |
¥ .~ Transform o,
Position X 0 Y3 Zo ]
Rotation X 50 Y |-30 'Z0 ]
Scale X1 Y1 |Z|1 ]
v o ¥ Light Q3%
Type | Directional s
Color | | 2
Mode | Misxed t]
Intensity |0.1 |
Indirect Multiplier 1 ]
Shadow Type | Soft Shadows ¢ ]
Baked Shadow Angle . 0

This gives the following layout

# Scene
Shaded

From here create a spotlight and position it in the field spots.

Here are the light settings:



Indirect Multiplier

| © Inspector | @ -=
| o ™ SpotLight (1) (] Static ¥
Tag | Untagged | Layer | Default s
¥ .~ Transform = &,
Position X 15.99 1Y |[3.72 'Z0.78 |
Rotation X 126.81 'Y 113,148 1Z2/95.12 |
Scale X[1 Y1 'zl |
v ¥Light TR
Type | Spot ¢
Range 12 ]
Spot Angle ) 80
Color [ | #
Mode | Realtime $ ]
Intensity 5 ]
1 |

Apply this to each field light and your unity world should look like this:

Notice how even with those lights, the field lights ae missing something, from here, add a point light
to each field light, this will be the bulb of the light

Here are the point light settings:



© mnspector | e

& Point Light (1) |_| Static *

Tag | Untagged ¢ | Layer | Default s |

¥ .~ Transform < o,
Position X|-2.24 Y 3.61 'Z-1.07 ]
Rotation X0 Y0 'zlo |
Scale X[1 | ¥ |1 'zl ]
v . ¥ Light W 5! &
Type | Point 3]
Range 10 ]
Color [ | 2
Mode | Realtime $)
Intensity 1 ]
Indirect Multiplier 1 ]

| |

Here is the output:




